It’s great to be Mac users.

Robin and John
Contents at a Glance

Mac OS X Basics for New Mac Users
Lesson 1 Introduction to the Mac OS X Desktop .................................................. 3
Lesson 2 A Bit Beyond the Basics ........................................................................ 35

Mac OS X Applications in Leopard
Lesson 3 Introduction to Mac OS X Applications .............................................. 47
Lesson 4 TextEdit for Word Processing ............................................................. 57
Lesson 5 Mail for Email and Notes ................................................................. 75
Lesson 6 Address Book for Contact Info ......................................................... 109
Lesson 7 Safari for Web Browsing and News ................................................. 129
Lesson 8 iCal for Organizing Your Life ......................................................... 155
Lesson 9 iChat and FaceTime for Text, Audio, and Video Messaging ........ 167
Lesson 10 iTunes for Your Listening Pleasure ............................................... 187
Lesson 11 Preview for Viewing Images and PDFs ............................................ 201
Lesson 12 Miscellaneous Tools on Your Mac ................................................ 221
Lesson 13 Common Tools in Mac OS X Applications ..................................... 247
Lesson 14 Working between Mac OS X Applications .................................... 261

Make it Your Own Mac
Lesson 15 Personalize Your Mac to Meet Your Needs .................................... 273
Lesson 16 Mission Control to Organize Your Space ....................................... 295
Lesson 17 Set Up Printing and Scanning ....................................................... 313
Lesson 18 Share One Mac with Multiple Users ............................................. 327
Lesson 19 Find What You Want, Fast—with Spotlight .................................. 351
Lesson 20 Time Machine Backup ................................................................ 371

Tech Stuff
Lesson 21 Get Connected and Share Files .................................................... 381
Lesson 22 Basic Troubleshooting ................................................................ 407
Lesson 23 Secure Your Mac and its Files ...................................................... 419
Lesson 24 Upgrade Your Mac and Migrate Your Files .................................. 433
# Contents

1 **Introduction to the Mac OS X Desktop** .................................................. 3  
   Get to Know Your Desktop and Finder .................................................... 4  
      Make sure you can get to the Desktop or Finder whenever necessary .... 5  
   Get to Know Your Finder Window ............................................................. 6  
      Become comfortable with “swiping” ..................................................... 7  
      Use the buttons in the Finder Window .................................................. 7  
      Hide/Show the Toolbar, Sidebar, Path Bar, and Status Bar .................. 7  
   Get to Know Your Sidebar and its Home Folders ...................................... 8  
      What each folder in your Sidebar is for ............................................. 9  
   Create Your Own Folders ........................................................................ 10  
   Take Advantage of the Sidebar ................................................................ 12  
      All My Files ......................................................................................... 13  
   Change the View of the Finder Window .................................................... 14  
      The Icon View .................................................................................... 14  
      The List View ..................................................................................... 15  
      The Column View ............................................................................... 16  
      The Cover Flow View ......................................................................... 18  
   Use Gestures to Navigate Your Mac ........................................................... 19  
      On a Magic Mouse .............................................................................. 19  
      On a trackpad ...................................................................................... 19  
   Quick Look ................................................................................................ 20  
   Use the Dock ............................................................................................. 22  
      Is the Dock missing? ........................................................................... 23  
      Documents and Downloads folders in the Dock ................................... 24  
   Use the Trash ............................................................................................ 26  
   Take Advantage of Keyboard Shortcuts .................................................... 28  
      Recognize the common modifier keys .............................................. 28  
      Use a keyboard shortcut ................................................................. 29  
      Notice gray versus black commands ............................................. 29
# Contents

Learn More About Mac OS X .......................... 30  
Tool tips ............................................. 30  
Hover tips ........................................... 31  
Help files ............................................ 32  
Support pages ....................................... 33  
Mac video tutorials ................................ 33  
MobileMe tutorials .................................. 33  
Apple Support Communities ...................... 33

## 2 A Bit Beyond the Basics ................................. 35

Understand the Sections of the Sidebar ................. 36  
Favorites ............................................ 36  
Shared ................................................ 36  
Devices .............................................. 37  
View your Home folder from the “Hard Disk” .......... 38

Understand the Various Library Folders ................. 39

Select Multiple Items in the Finder ...................... 40  
In the Icon View .................................... 40  
In the List View, Column View, or Cover Flow view ... 40

Look for Contextual Menus ............................ 42  
Open and Save As dialog boxes ....................... 44

## 3 Mac OS X Applications in Lion ......................... 47

Introduction to Mac OS X Applications .................. 47  
Know Your Applications Folder ....................... 48  
Use the Launchpad .................................. 49  
Know the Common Features of Mac Apps ............... 50  
Full-Screen Apps ................................... 54  
Application Integration ................................ 55  
What We Can’t Cover! .................................. 55

## 4 TextEdit for Word Processing ......................... 57

Create and Save a TextEdit Document .................. 58  
AutoSave and versions ................................ 59  
Restore a previous version ............................ 59  
Find and Replace Words or Phrases ..................... 60  
Paste Text to Match the Existing Text ................ 61
Contents

Use Your Favorite Text Styles Easily ............................................. 61
Tabs and Indents ........................................................................ 62
Create Lists that Number Themselves ...................................... 64
Create Tables ........................................................................... 65
Print Automatic Page Numbers ................................................. 66
Automatic Spelling Correction ................................................... 66
Select Non-Contiguous Text ...................................................... 67
Show Substitutions ..................................................................... 68
   Use typographer’s quotes ....................................................... 68
   Create live web links and email links .................................. 68
   Use Data Detectors ............................................................... 70
   Change case (as in upper- and lowercase) ........................... 70
Extra Tips and Notes ................................................................. 71
Read Microsoft Word Files ....................................................... 72
   Change the default application to open Word files ............ 72
   Save TextEdit files as Word docs ....................................... 73
   Save TextEdit files as PDFs ................................................. 73

5 Mail for Email and Notes ....................................................... 75
Set Up a New Email Account .................................................... 76
   Edit, delete, add, or put on hold an account ...................... 80
Read Your Email ........................................................................ 81
   Features of your email window ......................................... 82
   Conversations in your email window ................................. 84
Compose and Send a Message .................................................... 86
   Customize the message window ...................................... 87
Use Stationery to Send Fancy Email ......................................... 88
   Save as stationery ............................................................... 89
Create Mailboxes to Organize Your Mail ................................. 90
Filter Your Incoming Mail with Rules ....................................... 91
Smart Mailboxes ........................................................................ 92
   Create Smart Mailboxes .................................................. 93
Add Signatures to Your Messages .............................................. 94
Search Your Mail ...................................................................... 96
   Create a Smart Mailbox from a saved search .................... 97
Check Your Dock Icon ............................................................. 98
Create Notes for Yourself ........................................................ 99
   Create a new Note ............................................................ 99
   Sync iPhone Notes with Mail ........................................... 100
   View Notes in Mail .......................................................... 100
   Format and add attachments to a Note ........................... 101
Contents

6 Address Book for Contact Info ................................. 109
   How You’ll Use Your Address Book ......................... 110
   Create and Edit New Cards .................................. 111
      Add a photo to a card ..................................... 112
   Designate Your Own Card .................................... 113
   Add Fields to One Card or All Cards ....................... 114
   Check Out the Options ....................................... 115
   Map It ............................................................. 115
   Create a Group .................................................. 116
   Create Smart Groups in Address Book ..................... 117
   Search Your Address Book ................................... 118
   Send an Address Book Card to Others ..................... 119
   Merge Duplicate Cards ....................................... 120
   Invite Contacts to an iCal Event ............................ 121
   Share Your Address Book Contact List ..................... 122
      Subscribe to someone’s Address Book .................... 123
   Print in a Variety of Ways .................................... 124
   Back up Your Entire Digital Database ...................... 126
   View Multiple Contacts with Exposé ....................... 127

7 Safari for Web Browsing and News ......................... 129
   Safari Web Browser ........................................... 130
   Browse in Full-Screen Mode .................................. 130
   Quickly Access Your Top Sites ............................... 131
   Bookmarks ....................................................... 132
      Organize your bookmarks with folders (Collections) .. 132
   Bookmarks in Cover Flow View ............................... 133
   Auto-Click to Open Entire Collection in Tabs ............. 134
   Fill in Forms and Passwords Automatically ................ 135
   Block Pop-Up Windows! ....................................... 135
   SnapBack to a Search Results Page ......................... 136
   Quickly Enlarge or Reduce a Web Page ...................... 136
Contents

Tabbed Browsing .......................................................... 137
Find a Word or Phrase on the Current Page ..................... 138
Email a Web Page or a Link to a Web Page ..................... 139
View PDF Documents .................................................. 139
Save a Page and Everything on It ................................. 140
Make a Web Clip Widget .............................................. 141
Print Web Pages .......................................................... 142
Private Browsing ........................................................ 143
Parental Controls ......................................................... 144
So What is RSS? ........................................................... 145
  View the existing RSS feeds in Safari ......................... 146
  Look for other RSS feeds ........................................... 147
  View all RSS articles in a collection ......................... 148
  Bookmark your favorite feeds ................................. 148
  View RSS feeds in Mail ........................................... 149
  Change the RSS preferences ..................................... 149
  Use RSS feeds as a screen saver .............................. 150
View the Reader Version of a Page ................................ 150
Make a Reading List ..................................................... 151
Use Multi-Touch Gestures in Safari ................................ 152
Safari Security ........................................................... 152
Cool Safari Tips .......................................................... 153

8  iCal for Organizing your Life .................................... 155
  The iCal Window ...................................................... 156
  Set Up Google, Yahoo!, or Exchange Calendars .............. 156
  Create Calendars ...................................................... 157
  Create a Group of Calendars .................................... 157
  Create Events .......................................................... 158
    Event invitations .................................................... 159
  Create Reminders .................................................... 160
    Email a Reminder ................................................... 160
  Automatic Birthdays Calendar .................................... 161
  Link Events and Reminders ...................................... 162
  Backup the Entire Calendar of Information .................... 162
  Preview Files Attached to Events .............................. 162
  Publish Your Calendar .............................................. 163
    Subscribe to Calendars ........................................... 163
  Use iCal in Full-Screen Mode .................................... 164
  Print in a Variety of Ways ........................................ 165
## 9 iChat and FaceTime for Text, Audio, and Video Messaging

- Set Up iChat ............................................. 168
  - A sample iChat Buddies panel and chat. ............ 168
  - Make the account active ............................ 169
- Create an iChat Buddies List ............................ 170
- Chat with One Other Person ............................ 171
- Put Multiple Individual Chats in one Window ............. 172
- Chat with a Group of People all Together ............... 173
- Audio Chat with One or More .......................... 174
  - Open an audio chat and invite others to join you ........ 175
- Video Chat with up to Three Other People ............... 176
  - With whom can you video conference? ................. 176
  - Audio and video preferences .......................... 176
  - Open a video chat and invite others to join you ....... 177
- iChat Effects .............................................. 178
  - Add backgrounds ..................................... 179
- iChat Theater ............................................. 180
  - Share iPhoto with iChat Theater ......................... 181
- Bonjour on Your Local Network .......................... 182
- Record Chats ............................................. 184
- FaceTime .................................................. 185

## 10 iTunes for Your Listening Pleasure

- The iTunes Window ....................................... 188
- Buy Music, Movies, or Television Shows .................. 189
- Download Album Art .................................... 189
- Create a Playlist ........................................ 190
- Import Songs from a CD ................................. 191
- Create a Smart Playlist ................................ 191
- Share Your Music ........................................ 192
  - Share (streaming) on your local network ............. 192
  - Home Sharing on your local network .................. 192
- Burn a CD of Your own Collection ....................... 194
- Watch Movies in iTunes .................................. 195
- Listen to Radio from around the World .................. 196
- Audiobooks in iTunes .................................. 196
- iTunes DJ, Genius Playlist, and Genius Sidebar ......... 197
- Print a CD Cover Insert ................................ 198
- Socialize Musically With Ping ............................ 198
- Tune in to Visual Effects ................................ 199
11 Preview for Viewing Images, PDFs, and more 201
   Open an Image or Folder of Images 202
   Unlock or Duplicate to Make Versions 203
   Crop an Image 204
   Adjust Image Colors or Size 205
   Make Screenshots using Preview 206
   Import Images from a Camera or Scanner 207
   Save an Image as Another Format 207
   Working with PDFs 208
      Display facing pages or continuous pages 208
      Search a PDF 209
      Create bookmarks in a PDF 210
      Copy text from a PDF to paste elsewhere 211
      Annotate a PDF 212
      Create a link on an existing PDF 214
      Digitize your actual signature for PDFs 216
      Fill in PDF forms 217
   Print or Fax from Preview 218

12 Miscellaneous Tools on Your Mac 221
   The App Store: A Shop in Your Dock 222
   Use a Burn Folder to Burn a CD or DVD 224
   DVD Player 226
      Display the thumbnail bar and controls 226
      Create bookmarks to find specific points in the video 226
      DVD region codes 227
      Make DVD video and audio adjustments 227
      Create your own personal disc jacket on the screen 228
      Go back to the Finder 228
   Create PDF Files 229
   Font Book 232
      Preview and install fonts 232
      Install fonts 232
      Preview installed fonts 233
      Create your own Collections 233
   Stickies 234
   Photo Booth 236
      Take a still picture 236
      Add effects to snapshots or video 237
      Create a special effects backdrop 238
      The 4-up option 238
      Make a movie clip of yourself at your computer 239
Contents

QuickTime Player ........................................ 240
  Play a movie or audio file ............................ 240
  Share a movie ........................................ 242
  Trim a movie or audio file ......................... 242
  Make a movie clip of yourself at the computer ... 244
  Make a new audio recording ....................... 244
  To share or export your movie .................... 245
  Make a new screen recording ..................... 245

13 Common Tools in Mac OS X Applications .......... 247
  Spell Checker ..................................... 248
  Other useful commands for spelling and grammar .. 250
  Fonts Panel ....................................... 252
  Preview ........................................... 252
  Effects ............................................ 253
  Collections ...................................... 253
  Favorites ........................................ 253
  Action button options ............................ 253
  Characters Viewer ................................ 254
  Data Detectors .................................... 255
  Colors Panel ...................................... 256
  Speech ............................................ 257
  Have your email read out loud .................... 257
  Use Services for recording speech ............... 257
  Preview Your Page before Printing ............... 258
  Make a PDF of a Page or Document ............... 258
  Dictionary Panel ................................. 259

14 Working between Mac OS X Applications .......... 261
  Work with Multiple Applications at Once .......... 262
  Switch between open applications ................ 262
  Switch back and forth between two applications .. 263
  Quit or hide applications ........................ 263
  Switch between multiple full-screen applications . 263
  Simplify Your Work with Drag-and-Drop .......... 264
  Move text around in a document window .......... 264
  Move text from one application to another .......... 265
  Make a text clipping on the Desktop ............. 265
  Add email addresses to a Mail message .......... 265
  Send contact information through email .......... 266
Contents

Make a web location file ........................................... 266
Save into a particular folder ....................................... 266
Take advantage of the page proxy ............................... 267
Open documents in other applications ....................... 268
Take advantage of spring-loaded folders .................. 268
Drag content, images, or files between applications .... 269
Take Advantage of Services ..................................... 270

MAKE IT YOUR OWN MAC

15 Personalize Your Mac to Meet Your Needs ............ 273

Customize the Dock ................................................. 274
Customize the Dock using System Preferences .......... 274
Resize the icons and the whole Dock .................... 275
Customize the Dock with the Apple menu or Dock menu .... 275
Customize the Finder ................................................. 276
Customize the General preferences ....................... 276
Create labels for files and folders ....................... 278
Choose what appears in your Finder window Sidebar .... 279
Choose file extensions and turn off the Trash warning .... 279
Customize the Inside of Finder Windows .................. 280
Customize the Icon View .......................................... 280
Customize the List View .......................................... 282
Add comments and show the Comments column ....... 283
Organize the columns in List View ................. 284
Customize the Column View .................................... 285
Customize the Cover Flow View ............................. 286
Customize the Desktop View .................................... 287
Take Advantage of the System Preferences .............. 288
Global versus user-specific preferences ............... 289
How to use the System Preferences ......................... 289
Customize the System Preferences pane .................. 292
Find the right System Preferences for your task ....... 293
16 Mission Control to Organize Your Space ............. 295
  Mission Control ........................................... 296
    Spaces .................................................. 298
    Exposé ................................................... 302
    Exposé for the Dock .................................... 304
  Take a Look at Dashboard ................................. 306
    Open Dashboard and the widgets ....................... 307
    Add widgets to your Dashboard ......................... 307
    Put Dashboard away ..................................... 307
    Determine how to open Dashboard ....................... 308
    Manage your widgets .................................... 309
  iCloud Automatic Storage and Syncing .................... 310
    Enable automatic downloading ........................... 311
    iTunes Match ............................................ 311

17 Set Up Printing and Scanning ............................ 313
  Set up Your Printer Before You Print ................... 314
    The software is important ............................. 316
  The First Time You Print to Your Printer ................ 317
  Access the Special Features of Your Printer ............ 318
  Access the Special Features of Your Software ........... 319
  Share Your Printer with Other Macs ....................... 320
  Having Trouble Printing? Check the Queue................ 322
  Check Your Printer Utilities .............................. 324
  Set up Your Scanner ....................................... 325

18 Share One Mac with Multiple Users ....................... 327
  Overview of Multiple Users ............................... 328
    Limitations of other users ............................. 328
    More than one Admin .................................... 329
  Guest User Is Already Created ............................. 330
  Create New Users .......................................... 331
  Create a Group ............................................ 336
  Log Out and Log In ........................................ 337
  Switch Users with a Click ................................ 338
  Allow Other Users to be Admins ........................... 339
  Let Users Adjust their own Settings ...................... 340
  Set Up Login Items ....................................... 341
  Share Files with Other Users .............................. 342
  Set Permissions for Shared Files ......................... 343
Apply Parental Controls .............................................. 344
  Set limitations on a user ........................................ 344
  Simple Finder ......................................................... 346
  Disable the Simple Finder ........................................ 347
Delete a User ............................................................... 348

19 Find What You Want, Fast—with Spotlight .................. 351
  The Many Faces of Spotlight ...................................... 352
    Spotlight menu ..................................................... 352
    Spotlight windows ................................................. 353
    Spotlight-powered search in many applications ............. 354
  But Before You Begin .............................................. 355
    Choose the categories for searching .......................... 355
    Create some privacy ............................................... 356
    Keyboard shortcuts to open Spotlight ......................... 356
    Don’t search just file names .................................... 357
    Expand your repertoire of searchable items ................. 357
    Expand the search with metadata .............................. 358
    Add keywords to files ............................................ 359
  Spotlight Menu ....................................................... 360
  Spotlight in the Finder ........................................... 362
    Quick search in a Finder window .............................. 362
    Narrow the search in a Finder window ....................... 363
    Sort Spotlight’s search results ............................... 363
    Use a Boolean search ............................................. 364
  Smart Folders and Spotlight ..................................... 365
  Spotlight Search in System Preferences ....................... 367
  Spotlight Search in Time Machine ............................... 367
  Spotlight Search in Mail .......................................... 368
  Spotlight Search in Address Book ................................ 368
  Spotlight Search in an “Open” Dialog .......................... 369
  Spotlight Search in a “Save” Dialog ............................ 369

20 Time Machine Backup .............................................. 371
  About Time Machine ............................................... 372
    What kind of disk to use as backup ........................... 372
  Create a Time Machine Backup .................................... 373
  Local Snapshots ....................................................... 375
  How to Use Time Machine .......................................... 376
  Do a Search in Time Machine ...................................... 378
TECH STUFF

21 Get Connected and Share Files ........................................... 381

   How Your Mac Connects to the Internet ............................... 382
       Check the port configurations .................................. 383
       Establish a new connection .................................... 383

   Troubleshoot Your Internet Connection ................................ 384
       Use the AirPort Utility .......................................... 386
       Unplug everything and reboot .................................. 386
       Call a friend, check your cables, talk to your ISP ............ 386

   Troubleshoot Your Mail Account ....................................... 387
       Setting up a new account ....................................... 387
       Working account (that’s not working) ......................... 388
       Use the Mail Connection Doctor ............................... 389

   Share Files on a Local Network ....................................... 390
       Simple networking ............................................. 390
       Wireless ......................................................... 390
       Ethernet cables ............................................... 390
       Just two computers? ........................................... 390
       What else you need ............................................ 391
       Peer-to-peer network ......................................... 391
       Sharing files on one computer ................................. 391
       Turn on Personal File Sharing ................................ 392
       Share files with Windows users ............................... 393

   Connect to Another Mac ................................................. 394

   Disconnect from a Shared Server ...................................... 398

   AirDrop ...................................................................... 399

   Bonjour—Share Files Locally through iChat .......................... 400

   Screen Sharing ................................................................ 401
       Set up screen sharing on both Macs ............................ 401
       Screen Share on your local network via your Sidebar ........ 402
       Screen Share on your local network through the Go menu .. 403
       Screen Share globally through iChat ............................ 404
22 Basic Troubleshooting ........................................... 407
  Hard Disk is Making Noise? ................................. 408
  Force Quit an Application ................................... 408
  Relaunch the Finder ........................................... 409
  Quit all Apps before Restart ............................... 409
  Restart .......................................................... 409
  Shut Down ....................................................... 409
  Repair Permissions ............................................ 410
  Verify and Repair Disk ...................................... 411
  Safe Boot ....................................................... 412
  Delete the Application Preference File .................. 413
  Check for Software Updates ............................... 414
  Create Another User and Test ............................ 414
  If You Forgot Your Password .............................. 415
  Use Target Disk Mode ...................................... 416
  Force a CD or DVD to Eject .............................. 417
  Report Crashes ................................................ 417

23 Secure Your Mac and its Files ............................... 419
  Know Your Security Options .............................. 420
  Passwords on Your Mac .................................... 421
    Password tips .............................................. 422
  Security System Preferences ............................. 423
  Low-Level Security Features ............................. 425
    Automatic login .......................................... 425
    Require a password to wake your Mac ............... 426
  Higher-Level Security Features ........................ 427
  Use Keychain Access for Protection ................... 428
  Consider FileVault for Heavy-Duty Protection ....... 430
  Laptop Precautions ........................................ 431
GOALS

Find and replace words or phrases
Create favorite styles for quick formatting
Take advantage of the “Complete” feature
Turn on typographer’s quotes
Become familiar with tabs and indents
Create lists and simple tables
Create live web or email links
Select non-contiguous text
Print page numbers
Learn how to open Microsoft Word documents and save TextEdit files as Word docs
TextEdit is a small yet surprisingly powerful word processor. Use it to write memos, letters, diaries, novels, grocery lists, memoirs, or any other text document. You can create simple tables and automatically numbered or bulleted lists, add shadows to type, insert images, search and replace text, and more. But it’s not a full-blown word processor such as Apple’s Pages (check the App Store in your Dock) or MarinerWrite (MarinerSoftware.com) or the sweet, new Pagehand (Pagehand.com). Although TextEdit can’t do all the fancy things a big word processor can, it’s excellent for many projects.

If you’ve never used a word processor before and you don’t know how to open an application and save files, enter text, select text for formatting, cut/copy and paste, etc., please read The Little Mac Book first! This chapter assumes you know the basics of working in a word processor.
Create and Save a TextEdit Document

Open TextEdit (it’s in your Applications folder and in Launchpad). Then from its File menu, choose “New.” A blank window opens for you to start typing.

Choose how you want to see the document: From the Format menu, choose “Wrap to Window” (below, left) or “Wrap to Page” (below, right).

**Save your document as usual** (from the File menu, choose “Save...” give it a name, and store it in a folder where you’ll find it again). As you continue to work on your TextEdit document, an “Edited” button appears in the top-right corner of the document window. This is a **visual clue** that the document has been changed and you might want to save the changes (press Command S).

You can click that “Edited” button or triangle to choose from several options:

- **Lock** prevents further changes. If you try to type, you get an option to **Unlock** it. This is not a secure lock—anyone can click the **Unlock** button.

- **Revert to Last Saved Version** gives you the option to revert to the last time it was saved (either by you or by TextEdit), or you can revert to an older version, as explained on the opposite page.

- **Browse All Versions**—see the opposite page.
AutoSave and versions

TextEdit automatically saves your document every hour as you work on it, as well as when you close it (it doesn’t ask—it just saves). In addition, you can (and should) save more often (press Command S).

As soon as you save and name a document, TextEdit keeps track of all previous versions of that document; that is, every time you save or TextEdit saves, a new version is stored. You can return to any of these versions, as explained below.

To manually save the current version, go to the File menu and choose “Save a Version,” or press Command S.

To save a document with another name or in another file format, go to the File menu and choose “Duplicate.” Save this new file with a new name.

Restore a previous version

To turn to a previous version of the document, click the top-right corner to get the menu shown below. Choose “Browse All Versions...” All previous versions of your document appear, as shown at the bottom of this page.

Click on the title bars to go back in time to previous versions, or click in the vertical timeline to view various versions. When you find the one you want, click the “Restore” button at the bottom of the screen.
Find and Replace Words or Phrases

Did you write your entire screenplay using your sweetheart’s name, Hamlet, as the hero? And now Hamlet has abandoned you and you want to replace the hero’s name with Romeo? No problem:

1 From the Edit menu, choose “Find…,” or press Command F. A search field appears below the ruler bar.
2 Click the “Replace” checkbox to open a Replace text field below the search field.
3 In the Find field, type the word you want to find, such as Hamlet.
4 In the Replace field, type the word or phrase that will replace the found word, such as Romeo.
5 Find and replace:
   Replace: Replaces the currently selected occurrence of the word or phrase, then automatically finds the next occurrence.
   All: Replace all occurrence of the found text. Press (don’t click) on the “All” button to see more options.

To manually find other occurrence of the text, click the Previous and Next buttons.

For more search options, click the small double-arrows next to the magnifying glass icon on the left side of the window.

6 Click “Done” to put the Find and Replace fields away.
Paste Text to Match the Existing Text

This is one of my favorite features. Let’s say you’re writing a term paper and you copy a quote from a web page to add to your paper (properly cited, of course). Typically the copied text pastes in with the typeface, style, size, and color that were originally applied to it. But to add this quotation to your term paper, you want it to look like the rest of your page. Use this great feature instead of the regular paste:

From the Edit menu, choose **Paste and Match Style,** or use the keyboard shortcut, Option Shift Command V.

The pasted text will pick up all the formatting from the character to the left of the flashing insertion point. This technique works in Mail as well.

Use Your Favorite Text Styles Easily

TextEdit doesn’t have the powerful style sheets of a full-blown word processor, but it does make your writing life much easier by letting you create **favorite styles** of basic type features so you can apply them quickly. A “style” contains all of the formatting information, such as typeface, size, color, indents, etc., so you can apply everything to selected text with one click of a button.

These styles are saved with TextEdit, not with an individual document, so you can use the same styles in different documents.

**To create your own favorite style:**

1. Type some text, any text, and set up the typeface, size, color, linespace, and the ruler the way you want it.
2. Click anywhere in that formatted text.
3. Click the **Paragraph Styles** button, then choose “Show Styles…”
4. In the sheet that slides down (right), click the button, “Add To Favorites.”
5. Name the style and choose your options. Click “Add.”

**To apply a style,** select a range of characters, then choose the style name from the **Paragraph Styles** pop-up menu in the toolbar. All of the formatting that you saved with that style will be automatically applied to the selected text.
Tabs and Indents

The tab and indent markers in TextEdit function as in any word processor.

To set a right-aligned tab, single-click in the ruler.

To set any other tab, Control-click (or right-click) in the ruler and choose a tab marker (shown below), or double-click a marker to change it.

To remove a tab, drag the marker off the ruler.

To indent just the first line of text or both the left and right edges, drag the indent markers shown below.

Examples of tab and indent settings

The following are some examples of how to set up your tabs and indents to create certain effects. Remember, after you’ve set a tab, hit the Tab key before you type the text. Once you’ve got tabs set up, you can select the text, then move the tab and the selected text will follow.

The tab applies only to the selected paragraphs—you only need to click inside a paragraph to select the entire paragraph. To select more than one paragraph, press and drag to highlight a range of text in each paragraph. Follow the directions as explained in each window and its caption.
To create an outdent, where the first line is outdented farther than the other lines: Move the Left Indent marker (the triangle) to the right of the First Line Indent marker.

To indent an individual paragraph on both sides: Select the paragraph, then move both the Left Indent and the Right Indent markers inward.

To create columns: Remove all tabs except the few you need, and reposition those about where you want the columns to align. Now hit ONE tab to move the insertion point to the first column, and type. Hit ONE more tab to get to the second column, etc. At the end of the line, hit a Return and start over.

This is a common setup. It might seem a little tricky at first, but once you get it, you’ll love knowing how to do it. Set the markers as shown and follow the directions.
Create Lists that Number Themselves

If you have a list of items, TextEdit can number them for you with numbers, capital or lowercase letters, or other options. When you add or delete items from the list, TextEdit automatically updates the numbering.

When you click the List button (circled above) and choose a numbering option, the numbers apply to either of the following:

If you select text on the page before you go to the Lists menu, your choice of list numbering will apply only to the selected text.

If there is no selected text, the flashing insertion point is “filled” with the list specifications, and everything you type from that point on will be in the list format. This is a good way to start a new list: Just make sure your insertion point is flashing where you want the list to begin, then go to the List menu and choose your numbering system, then start typing.

Each time you hit a Return, TextEdit considers that line to be the next item in the list.

To end the sequencing of numbers in a list, hit the Return key twice at the end of the last item.

To delete the list numbers, single-click anywhere in the list. Open the Lists menu and choose “None.”

To easily access the advanced List options after you’ve started a list, click anywhere within a list, then Control-click (or right-click) in the list to show a contextual menu and choose “List....”
Create Tables

If you like working with tables, you can create simple ones in TextEdit. This table feature also helps ensure that tables created in a Word document will open in some form in TextEdit.

**To create a table in TextEdit:**

1. Position your insertion point where you want the table to begin.
2. Go to the Format menu and slide down to “Table...”
3. The Table palette appears, as shown below. Choose how many rows and columns you want in the table. You can determine how the text is aligned vertically as well as horizontally in each cell (use the “Alignment” icons), and more. Spend a few minutes to familiarize yourself with the tools.

As you **type in a cell**, the cell expands downward to fit the text.

**Change the formatting of the text** as you do on a regular TextEdit page: Select the text first, then choose the settings from the menus or toolbar.

4. **To resize rows and columns**, position your pointer over the edge of a cell. The pointer turns into a two-headed arrow. With that two-headed arrow, press-and-drag on a cell edge to resize it.
Print Automatic Page Numbers

You can add page numbers to a *printed* document (the numbers won’t appear on the screen). This feature also automatically adds the name of the document in the upper-left corner of the page (including the extension, probably .rtf), the date and time in the upper-right corner, and the words “Page ___ of ___” in the bottom-right corner. That is, in TextEdit you can’t choose one or the other of these—they all appear on the page, or none.

**To print the page numbers** (and everything else), press Command P (or go to the File menu and choose “Print...”). In the Print dialog box, shown below-left, click “Show Details.” In the expanded Print dialog (below, right), check the box to “Print header and footer.” Click “Print” to print the document.

Automatic Spelling Correction

TextEdit can automatically correct many spelling errors as you type. To enable this feature, open the TextEdit Preferences (from the TextEdit menu). Make sure the “New Document” tab is chosen. Toward the bottom of the window, check the “Correct spelling automatically” box. Close the Preferences pane.

If TextEdit can’t figure out how to spell it or if automatic correction is turned on, you’ll probably see a red dotted line under misspelled words. See pages 248–251 to learn to use the spell checker.
Select Non-Contiguous Text

This is really quite wonderful. “Contiguous” means “sharing a common border.” Very few applications allow you to select individual sections of text that are not physically next to each other (text that is non-contiguous). This technique lets you apply formatting or copy, cut, or delete separate sections of text all at once.

To select non-contiguous text:
1. Press-and-drag to select a section of text.
2. Hold down the Command key. Press-and-drag to select some other text that is not contiguous!
Show Substitutions

TextEdit “Substitutions” (from the Edit menu or contextual menu) makes automatic substitutions for you as you type. For instance, “Text Replacement” corrects obvious spelling mistakes (it substitutes the for teh, etc.) and turns a typed fraction, such as 7/8, into a real fraction, %. Below are several of the other substitution options.

Use typographer’s quotes

TextEdit provides typographer’s quotes, or Smart Quotes. Smart quotes (and apostrophes) are the curly quotes, not the straight, typewriter quotes. Nothing will make your work look as amateurish as typewriter quotes.

*typewriter quotes*  
*smart quotes*

It’s “QueenB” to you. It’s “QueenB” to you.

The Substitutions panel provides extra options for Smart Quotes so you can activate automatic quotation styles for other languages. Turn Smart Quotes off when you want to type feet and inch marks. For instance, I am 5’7” tall, not 5’7” tall. To get this panel, go to the Edit menu, choose “Substitutions,” and then choose “Show Substitutions.”

Create live web links and email links

It’s easy to create web links and email links on a TextEdit page. If you send someone the TextEdit file, that person can click on a web link; her browser will open and go to the page you specify. An email link in the document opens her email program, pre-addressed to whomever you specified.

If you make a PDF of your document (see page 73), the links will work in the PDF.

Create links as you type web addresses:

1. Go to the Edit menu, slide down to “Substitutions,” then choose “Smart Links.”
   
   If there is a checkmark next to “Smart Links,” it’s already on.
Or Control-click in the document, slide down to “Substitutions,” then choose “Smart Links.”

2 On your TextEdit page, just type the web address. You don’t need the www part of the web address, or the http:// part. If the address ends with .com, .edu, or .org, the link appears automatically. You’ll know if it’s working because the text will turn into a blue, underlined link.

If the domain (the .com part) is more unusual, such as .info, you’ll have to manually add the link, as explained below.

Sometimes the text on the page is not an actual address, but you want the link to go to an email or web address. For instance, perhaps you wrote, “Please visit our Mary Sidney web site,” and you want the link attached to “Mary Sidney” to go to MarySidney.com, or you want to say Email me! as a link to your actual email address. In either case, use the manual process described below to add a link.

To manually create a web link or an email link on a TextEdit page:

1 Type the text that you want to turn into a link. This text can be anything—it doesn’t have to be the email or web address itself!

2 Select the text that you just typed in.

3 From the Edit menu, choose “Add Link….”

4 Web address: type the address. Make sure you include this code at the beginning of the web address: http://

   Email: Type into the field: mailto:
   Immediately after the colon, type the entire email address just as you would address it: mailto:name@domain.com

5 Click ok.

To remove a link from the text on a TextEdit page:

1 Click in the text a few characters away from the link to set the flashing insertion point. Use the left or right arrow keys to move the insertion point into the linked text.

2 From the Edit menu, choose “Add Link….”

3 Click “Remove Link,” then click ok.
Use Data Detectors

Data Detectors is one of several Substitutions available in TextEdit that enhance your text. The Data Detectors feature, like Smart Links, makes your text interactive. When you hover the cursor over a street address or phone number in a TextEdit document, the cursor draws a marquee around the address and/or phone number. Click the triangle button that appears to show a contextual menu of options (circled, below). You will see different options depending on what is selected.

Data detection is probably turned on already. If it isn’t: To turn on data detection, go to the Edit menu, choose “Substitutions,” then select the “Data Detectors” option.

You can also right-click (or Control-click) on any empty spot in the document to open a contextual menu. Slide down to “Substitutions,” then choose “Data Detectors.” A checkmark next to a Substitution item means it is enabled; select it again to disable it.

Change case (as in upper- and lowercase)

The Edit menu also contains a command called Transformations to change the case of selected letters quickly and easily. That is, you can change a word that starts with a lowercase letter to one that starts with a capital letter, or if someone wrote you something in all caps you can change it to lowercase with the click of a button.

Select some text and Control-click (or right-click) on that selection, or simply Control-click (or right-click) directly on an unselected word. From the Edit menu, go to the Transformations submenu and choose “Make Upper Case,” “Make Lower Case,” or “Capitalize” (which capitalizes just the first letters of each selected word).
Extra Tips and Notes

**Ruler:** If the ruler isn’t showing, press Command R. Without the ruler showing, you can’t set tabs, indents, or margins.

**Formatting:** If text won’t let you apply formatting, go to the Format menu and choose “Make Rich Text.”

**Wrap to Page:** If text stretches the entire width of the window, you might want to switch to “Wrap to Page.” Go to the Format menu and choose “Wrap to Page.”

**If your text prints really tiny,** go to the Format menu and change “Wrap to Window” to “Wrap to Page.”

**Complete:** To automatically complete a word that you start typing (a word that you’re not sure how to spell, or a word that’s so long you don’t want to type it all), go to the Edit menu and choose “Complete,” or use the keyboard shortcut Option Escape. A pop-up menu that contains a list of possible matches opens. Select the word you want from the list, then hit Return (or click the word in the list).

**Speech:** Let your Mac read selected text to you aloud. Go to the Edit menu, choose “Speech,” then choose “Start Speaking.” To stop the speech, choose “Stop Speaking.” To read aloud just a certain portion of text, select that range of text, then choose the “Start Speaking” command.

**Look up words in the Dictionary:** To look up a word (such as “Santa Fe”) in the Dictionary, right-click on the word or the selected phrase to open a contextual menu, then choose *Look Up “Santa Fe.”*  

If your trackpad supports multi-touch gestures, double-tap the word with three fingers to look up the selected word, as shown below. Your own gesture commands may vary, depending on the Mouse or Trackpad settings in your System Preferences (see page 290).
Read Microsoft Word Files

Do you need to send or read Microsoft Word files, but you prefer to keep a Microsoft-free environment on your own computer? TextEdit can open Word files and save as Word files. Some of the advanced features will be missing, but this works great for basic text documents, including those with simple tables or numbered/bulleted lists.

If you don’t have Microsoft Word installed on your Mac, file names ending with .doc or .docx (which are usually Word files) automatically open in TextEdit when you double-click them.

To force a Word document to open in TextEdit (if it doesn’t automatically), drag the file and drop it on the TextEdit icon.

If TextEdit is not in your Dock, it’s in the Applications folder and in Launchpad: Click the Launchpad icon in the Dock. Find the TextEdit icon, then drag and drop it in the Dock so it’s always easily accessible.

Change the default application to open Word files

If you own Microsoft Word and want your .doc files to open in Word, not TextEdit, you can change the default application:

1 Control-click (or right-click) the Word document icon to get its pop-up menu.
2 While the menu is visible, also hold down the Option key. This changes the “Open With” command to “Always Open With.”
3 Choose “Always Open With.” If Microsoft Word is on your Mac, you’ll see it listed in the pop-out menu. Or select “Other...,” then choose the application you want to always open the selected file.
Save TextEdit files as Word docs

You can save any TextEdit file as a Microsoft Word document to send to people who insist on that format.

To save a TextEdit file as a Word document:

1. Go to the File menu and choose “Duplicate.”
2. Press Command S to save this duplicate.
3. In the “File Format” menu at the bottom of the dialog box, choose “Word 2007 Format (docx).” This automatically adds the Word extension, .docx, to the end of your file name.

If you don’t see an extension (see page 444) at the end of a file name—and you want to—click the disclosure button to the right of the “Save As” field (circled below). Uncheck the box to “Hide Extension.” To show the extension, of course, check the box.

Save TextEdit files as PDFs

From the File menu, choose “Print…,” then click the “PDF” button (in the bottom-left corner of the Print dialog). Choose “Save as PDF…”
Index

abbreviations at ends of file names, 73, 279, 443
Action menu, 43, 53
Active Screen Corners, 298, 303
active window, what is it? 443
Address Book, 109–127
add contacts
  from Mail messages, 110
  manually, create a new card, 111
  with data detectors, 103
alphabetize contact list, 111
autofill info in Safari windows, 135
back up entire database of contacts, 126
birthdays, add them to iCal, 161
data detectors can add info, 255
display addresses, 110
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
edit an existing card, 111
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single card or card and list, 111
display addresses, 110
data detectors can add info, 255
display single ca...
battery power
keyboard, how much is left in, 289
mouse, how much is left in, 290
Bing, search with in Safari, 130
Bonjour, as part of iChat, 182, 400
bookmarks
Safari bookmarks, 132
DVD movies, make bookmarks in, 226
Boolean operators,
search with, 364
browser. See Safari.
Burn Folder to burn a CD or DVD, 224, 225
C
calendar software. See iCal.
Carter, Ross, 57 (Pagehand), 228
CDs and DVDs
audio CDs
import music into iTunes, 191
burn audio disks, 194
burn disks
of data, 224–225
of music, 194
disk is stuck in the drive, 417
eject a CD, 37
how much do they hold? 224, 225
icon in Finder window Sidebar, 37, 276
icon on Desktop, hide or show, 37
transfer files with, 440
unburned disk, how to eject, 225
Characters viewer, how to use it, 254
chat. See iChat, FaceTime.
Chinese characters, 254
clean install Lion OS, 435
Clean Up windows or Desktop, 281, 287
clip art,
how to add to text, 254
clutter on your Desktop, manage it with Mission Control, 296–305
color labels, 278, 443
Colors panel, 256
Column View in Finder windows,
16–17, 38
add other sort columns to window, 278
file sharing, keep track of which computer you’re using, 394
customize the Column View, 285
rearrange the columns, 278
can’t rearrange the columns, 280–285
resize text and icons in, 285
select multiple items in, 40–41
Command key
keyboard shortcuts with, 28–29
select multiple files with, 40
computer name, 392
connect to the Internet, 382–405
assistance for connecting
ISP (Internet Service Provider), 385, 386
online, 383
Locations for connectivity, 384–385
Network Diagnostics tool, 385
Network system preferences, 382–385
reset button on modem box, 386
set the connection order, 383
troubleshoot your connection, 384–386
contact sheet of photos
in Mail, view attachments as, 106
in Preview, 202, 208
in Quick Look, 21
contextual menus
how to use them, 42–43
Address Book contact search, 368
change default app to open files with, 72
change toolbar view, 43
Control key symbol, 28, 443
data detectors, 255
dictionary
access Dictionary at any time, 71
add words to user dictionary, 249, 251
Dictionary panel and more, 259
Get Info on a file, 283
labels, apply colored labels to files, 278
Mail icon in Dock shows messages, 98
read text aloud, 43
set up the secondary click/right-click, 290
show Inspector pane, 283
spelling
spell check, 43
add the word to the dictionary, 249, 251
fix spelling, 251
contiguous, what is it? 67
Conversations in Mail, 84–85
copy
documents with the page proxy, 267
music from iTunes, 192–193
paste and match style, 61
Cover Flow view
of bookmarks in Safari, 133
in Finder windows, 18
select multiple items in, 40–41
crop a photograph in Preview, 204
currency symbols, 254
Cyrillic characters, 254
Dashboard, 306–311
how to open it, 307, 310
manage your widgets, 311
occupies its own Space, 297, 298
web clip widget, make one in Safari, 141
Widget Bar, hide or show it, 306–307
data detectors
overview of, how to use, 255
icons to open in Quick Look, 21
in Mail, 82, 102–103
in TextEdit, 70
Date & Time preferences, 291
deauthorize computer, 438
DemonBells, 84–85, 104–107
Desktop
what is it? 4–5
customize
the Desktop background, 291
the Desktop view of files, 287
Desktop folder in Home folder, 9
Hard Disk icon on Desktop, 4, 276
Desktop & Screen Saver preferences, 291
Devices item in Finder windows, 37
hide the device names, 6, 36
dial-up connection, Mail preferences for checking Mail, 81
Dictionary application
Dictionary contextual menu, 71, 259
Spotlight search accesses Dictionary, 360
widget for Dictionary, 309
disconnect from shared volumes, 398
disk images, create encrypted ones, 427
disks
burn data onto, 224–225
burn music onto, 194
is stuck in the drive, 417
encrypt a disk image for security, 427
external disk for transferring files, 440
partition the hard disk, 436
Disk Utility
partition the hard disk, 436
repair disk permissions, 410, 436
repair disk, 411
dividing line in the Dock, 22–23
divination characters, 254
Dock
what is it and how to use it, 22–25
Applications folder, add to Dock, 48
App Store icon in, 222
customize it to suit your needs, 274–275
dividing line, options on, 275
Dock Exposé for managing application
windows, 304–305
Downloads folder in, 105
view contents in and customize view, 107
hide or show the Dock, 274–275
icons in Dock
make them bigger, 274–275
minimize application windows
behind icon, 275
show indicator lights for open apps, 274
Dock Exposé
for managing application
windows, 304–305
Downloads folder in, 105
view contents in and customize view, 107
hide or show the Dock, 274–275
icons in Dock
make them bigger, 274–275
minimize application windows
behind icon, 275
show indicator lights for open apps, 274
Dock Exposé
for managing application
windows, 304–305

drag-and-drop
contact info, send through email, 266
Mail, add name to message, 265
miscellaneous tasks with, 269
open documents into other apps, 268
page proxy to copy, email, iChat, 267
save a file into a specific folder, 44, 266
spring-loaded folders, drop files into, 268
text clippings, how to make, 265
text from one app to another, 265
text in a document window, 264
web location file, how to make one, 266
Drop Box
set permissions to create, 444
share files through
from another computer, 394
users on one Mac, 342
DVD Player, 226–228
bookmarks in a DVD, how to create, 226
disk jacket, create one for a DVD, 228
DVDs
burn a data DVD, 224–225
cREATE Personal disk jacket for display, 228
eject a DVD, 37
how much does a DVD hold? 224, 225
icon in Finder window Sidebar or on
Desktop, hide or show, 37, 276
IDVd is not covered in this book, 55
movies, watch with DVD Player,
226–228
region code, change it, 227
stuck disk, how to get out, 417
unburned disk, how to eject, 225
Edit menu, 50
eject
disk is stuck in computer,
how to get it out, 417
symbol for, 37
unburned disk, how to eject, 225
e-mail. See Mail
emotions, add to your text, 254
empty the Trash, 26–27
Empty Trash securely, 279
put back an item you put in Trash, 27
encryption
encrypted disk images, create them, 427
FileVault encrypts your Mac, 430–431
Ethernet switch to network Macs, 391
Exchange
set it up calendere in iCal, 156
set it up in Mail, 77–79
set it up in System Preferences, 76
sync Address Book with, 111
Exposé
Address Book contacts in, 127
Dock Exposé to manage app windows,
304–305
preferences for, 298, 303
extensions
what are they? 444
hide or show extensions, 73, 279
FaceTime
how to use it, 185
Address Book, make video call from, 115
icon in Dock, 22
fast user switching, 334, 336, 338–339
fav icon in Safari location field, 266
Favorites section in Finder windows, 36
faxing
PDFs, send to fax, 230
Preview, fax from it, 219
feet and inch marks, 68
file formats
extensions indicate the file format,
73, 279, 444
Preview can change file formats, 207
save as a different file format, 73
File menu, 50
files
attach to email, 104
comments, add to a file, 283
display file size of graphics, 281, 282
find earlier versions through
Time Machine, 376–378
hide or show extensions to names, 73, 279
lost files, search Time Machine, 378
open a file you created earlier, 44
organize files with colored labels, 278
Postscript, save a file as, 230
save a file into a particular folder, 44
secret love notes in a file, 283
versions of, 59, 203
file sharing
afp for file sharing, 396
AirDrop, share files with, 399
Apple id, connect using it, 394–397
Bonjour, share files locally, 182–183, 400
connect to another Mac to share files,
394–397
disconnect from other Macs, 397, 398
Drop Box
share files between users, 342
share files from another computer, 394
Go menu
connect to other Macs, 396–397
screen sharing, connect to server, 403
Group user account and file sharing, 336
Finder preferences

advanced preferences, 279, 353
Desktop
  background image for, 291
  Hard Disk icon, show on Desktop, 4, 276
  show connected servers on Desktop, 398
  preferences for view, 276, 287
general preferences, 276–277
label colors for files, 278, 443
search options in, 353
Sidebar items, hide or show, 13, 279
  show connected servers in Sidebar, 398
Finder windows
what are they? 4
window features explained, 6
arrangement of items in window
  Arrange by menu, 6, 280–285
  in Icon View, 280–281
  in List View, 282–284
change the view of, 14–18
Column View
  basics of, 16–17
  customize the Column View, 285
  resize text and icons in, 285
Cover Flow View in, 18, 286
defaults
  create defaults for window views, 280
  restore window to original view defaults, 280, 282
grid spacing in windows, control it, 281
Home folder icon in, 8–9, 279
icons
  enlarge size of text label, 281
  eyeball in Toolbar (Quick Look), 20–21
  resize icons
    in Column View, 285
    in Cover Flow view, 286
    in Icon View, 6, 280–281
    in List View, 282
show previews of files, 281
Icon View in
  basics of, 6, 14
  customize the view of, 280–281
  rows of files, why is that? 280–285
labels column, show it, 278
List View in
  add color labels column in, 278
  add comments to a view and view them in the window, 283
  add or delete columns, 282–283
  basics of, 15
  customize the List View, 282–284
  organize the columns in, 284
minimize windows
  choose Genie or Scale effect, 275
  click the yellow button, 7, 304–305
move a window, 6, 50
open windows
  in a new, separate window, 17
  control windows with Exposé, 302–305
Path bar in, 6–7
preferences for, 276–279
Quick Look icon in Toolbar, 20–21
red, yellow, green buttons in, 7
resize the window, 6
rows of files, why is that? 280–285
Sidebar
  add or remove items from, 279
  Burn Folder, add to Sidebar, 224
  gear icon in, Smart Folder, 366
sort items with or without
  an arrangement, 285
spring-loaded folders and windows, 276–277
Status bar in, 6–7
text size of the labels, resize it, 280–281, 282, 285
Title bar in, 6
Toolbar in, 6–7
View buttons in, 6

finger someone, 437
firewalls
  Firewall pane in Security prefs, 424
  part of security on Mac, 420
FireWire
  icon for FireWire, 416
  share files via FireWire, 441
  target disk mode, how to use it, 416
Fkeys, 28
Flash drive installer
  order for upgrading to Lion, 434
  reset Admin password with, 422
Flickr, export movies to, 242–243, 245
fn key
  affects keyboard shortcuts, 289
  use in combination with F9, 297
folders
  add notes to a folder file, 283
  application folders, 48
  Burn Folder to burn a CD or DVD, 224
  contextual menu for, 42
  create a new folder
    from a selected group of files, 42
    create your own new folders, 10
  display number of files in folder, 281
Dock, add folders to, 23
Launchpad folders look different, 49
move a folder, 11
open a folder, 11, 276–277
organize them with colored labels, 278
Public Folder, use it to share files, 342, 392–393
put something inside a folder, 11
rename a folder, 11
save a file into a particular folder, 44
  drag the folder to the Save As window, 266
  share specific folders with other computers, 392–393
  spring-loaded folders, 276–277
  stack folders look different, 25
Font Book, 232–233
fonts
Characters viewer, how to use it, 254
clip art, how to add to text, 254
disable specific fonts, 233
Fonts panel, 252–253
install fonts with Font Book, 232–233
preview fonts, 232–233, 252
shadow effects, add them, 253
stored in Library folders, 39
view only English language fonts, 233
force quit an application, 408
Foz, 286
full-screen mode
apps occupy their own Spaces, 297, 299
as part of Mission Control, 296–301
how to enter and exit, 54, 299, 300
in iCal, 164
GarageBand
icon in Dock, 22
not covered in this book, 55
gear symbol
Action menu, 43
Smart Folder, 366
Smart Mailbox, 92–93, 97
Smart Playlist, 191
gestures
choose the ones you want to use, 290
examples of using on your Mac, 7, 19
Address Book, show Exposé view of, 127
iCal, turn calendar pages with, 156
Mission Control, use with, 297
Safari, browse web pages with, 152
Spaces, maneuver with, 300
Get Info window
what is it? 443
add keywords for searching, 359
disk, how much space to burn, 225
file sharing permission in, 343, 393, 444
store comments in Get Info window, 283, 359
glyphs, preview available ones, 233
Go menu
file sharing, connect to servers, 396–397
screen sharing, connect to server, 403
Google
Gmail and other accounts
set it up in System Preferences, 76
set it up in Mail, 77–79
Google calendar
set it up in System Preferences, 76
set it up in iCal, 156
Google Talk account, 168
map a location from an Address Book contact, 115
from an email message, 103
grammar check, 248–251
gray vs. black commands in menu, 29
Greek characters, 254
green button to resize window, 7
green dots under words, 248, 250
green plus sign when dragging, 267
Grid view of Dock folder contents, 25
Haney, Brianna Nora! 234
hard disks
icon on Desktop, show or hide it, 276
makes noise? 408
name in Sidebar, 37
path to see files, 38
Target Disk Mode, use another computer as a hard disk, 416
Hebrew characters, 254
Help files, where are they? 32
hide all other or the open application, 263
Home folder
what’s in it? 8–9
add your Home to the Sidebar, 8, 279
view its path, 38
Home Sharing, 192–193
Hot Corners for screen activity, 298, 303
hover
what is a hover? 31
display tool tips, 30
hide or show items in Sidebar, 36
show items in Sidebar, 394
HTML mail, 88–89
hub for connectivity, 391
iCal, 156–165
overview of window, 156
backup calendar data, 162
birthdays calendar, 161
calendar settings, set up in Mail, 76
calendars list, 157
create a new calendar, 157
data detectors
can add info to iCal, 255
in Mail, use to create Events, 102
delete a calendar, 157
e-mail
an invitation or notification, 159
a reminder to someone, 160
Events
create Events, 158
invite contacts from Address Book, 121
link them to Reminders, 162
notify others of Events,
get responses, 159
preview files attached to Events, 162
publish your calendar of Events, 163
full-screen mode, 164
group calendars, 157
icon in Dock, 22
invitations, send to people, 159
invitees are highlighted blue or not, 121
printing calendar pages, 165
Reminders, 160
link them to Events, 162
subscribe to a calendar of Events, 163
iChat, 167–185
account, get a chat account, 168
audio chat, 174–175
backgrounds for fun effects, 178–179
Bonjour to share files or chat on local network, 182–183
Buddies list, how to make one, 170
buddy name, where to get one, 168
chat rooms for groups of people, 173
data detectors, watch for them, 21
effects and backgrounds, 178–179
emojis in chat, how to add, 171
enable the account, 169
end a chat, 171, 173
examples of chats, 168, 171
of group chat, 173
file sharing
with Bonjour on local network, 400
with iChat Theater, globally, 180–181
with screen sharing, globally, 404
fonts and colors in chat, customize them, 169
green orb in Mail, 83
Group buddy list, 170
group of people, chat all together, 173
merge chats into one window, 172
message cloud, 182
multiple chats in one window, 172
organize your Buddies list, 170
phone, send text messages to, 170
photographs
photo of you or buddy, change it, 174
use Photo Booth to take photos, 236–239
record an audio or video chat, 184
save your text chats, 169
set up a new account, 76
share files, movies, web pages
with others, 180
smileys in, how to add, 171
Tab Bar in, 172
text chat
one on one, 171
with a group, 173
to a phone, 170
tool tips in, 31
track iChat use for a managed user, 347
visual effects and backgrounds
for fun, 178–179
icons
arrow (teeny tiny arrow) in bottom-left corner is an alias, 224, 443
Dock icons, 22
double arrows in right corner of windows (full-screen mode), 54
FireWire icon, 416
preview file image in Column View, 285
resize icons in Finder window
in Column View, 285
in List View, 282
in Icon View, 6, 14, 280–281
resize icons on the Desktop, 287
shared volume icon, 397
Icon View
arrangement of window, 280–281
enhanced Icon View, 14
preview movies and documents in, 14
resize icons in, 6, 280–281
select multiple items in, 40
View Options for, 14, 280–281
iTunes, 187–199
overview of the iTunes window, 188
account, get one, 189
add text as voice to iTunes, 257
album art, display it, 188, 189
audiobooks, buy and listen to, 196
buy music, movies, or TV shows, 189
controls for movie watching, 195
copy songs from one Mac to another, 192–193
deauthorize your Mac before migrating files, 438
DJ, automatic mixes, 197
full-screen mode
button for, 188
while watching movie, 195
Genius Playlist, automatic list from your Library, 197
Genius Sidebar, 197
show or hide Sidebar button, 188, 197
Home Sharing, 192–193
icon in Dock, 22
import songs from CDs, 191
iTunes DJ, automatic mixes, 197
iTunes Match, 311
iTunes U, 187
lectures and courses, iTunes U, 187
movies
export from QuickTime Player, 242, 245
transfer a movie from one Mac to another, 192
watch movies in iTunes, 195
PDFs, add to iPhone or iPad, 230
Ping, 188, 198
Playlists
album art, display it, 188, 189
control playback, 188
create Playlists, 190
Genius Playlist, 197
iTunes DJ, 197
play songs, 188
preferences
choose what to display in Sidebar, 190
share your music, 192
print CD covers, 198
recommends songs for you, 197
search field, 188
share your music on a local network, 192–193
shuffle music playback, 188
Sidebar in, 52
choose what to display in, 190
gear icons, Smart Playlists, 191
Genius Playlist in, 197
iTunes DJ in, 197
Smart Playlists create them, 191
examples of in Sidebar, 190
genius Playlist in, 197
iTunes DJ in, 197
Smart Playlists create them, 191
examples of in Sidebar, 190
sync Address Book to devices, 110
time tv show, watch them in iTunes, 195
transfer songs or movies to another computer, 192–193
Visualizer, visual reactions to music, 199
iWeb, not covered in this book, 55
Jabber account, 168
Jonson, Ben, 31
JPG files, change to another format, 207
Kerberos, 420
keyboard change keyboard language, 293
system preferences for, 289
wireless keyboard, how much battery power is left? 289
keyboard shortcuts how to use them, 28–29
fn key affects shortcuts, change its setting, 289
modifier keys for, 28, 445
paste and match style, 61
Keychain Access what is it? 420
how to use it, 428–429
password for Keychain Access, 422
screen saver lock for security, 426
Keynote, not covered in this book, 55
keywords, add to files, 359
Korean characters, 254
labels what are they? 443
organize files and folders with colored labels, 278
languages currency symbols, 254
quotations marks for, 68
special characters in, type them, 254
spell check in another language, 248
laptops date and time, set it for traveling, 291
fn key use, 289, 297
restarting, 409
security precautions for, 431
trackpade use. See trackpad.
Launchpad how to use it, 49
icon in Dock, 22
Library folders access Home Library folder, 413
access the invisible user Library folder, 39
List View can’t rearrange the columns, 283, 284
comments column available in, 283
customize the List View, 282–284
organize the items in, 284
select multiple items in, 40–41
Little Mac Book learn to use a word processor in, 57
proceeds at a slower pace, 3
local network what is a local network? 36
devices show in Sidebar, Shared, 36
file sharing on. See file sharing.
Local Snapshots in Time Machine, 375
Locations for Internet connectivity, 384–385
Lock Screen option in menu bar, 426
login to, logout of Mac as Guest, 330
automatic login, 334, 337
turn it off for security, 425
login window, customize it, 335
log out how to, 337
auto logout after certain number of minutes, 423
password hint for login, 335, 337
lookup, run one, 437
love notes, add to file Info box, 359, 283
MacBook Air, remote install OS, 441
Magic Mouse general use of with gestures, 7, 19
gestures in Address Book contacts, show Exposé view of, 127
in Mission Control, 297
in Safari, browse web pages, 152
in Spaces, move between Spaces, 300
in iCal, turn calendar pages, 156
options for, set them up, 290
Magic Trackpad. See trackpad.
magnifying glass in corner of screen, 352
Mail accounts choose from which account to send mail, 87
edit an existing account, 80
new email account, set it up, 76–79, 80
put an account on hold, 80
address a message
To field, 86
drag address from Address Book, 265
add sender to Address Book, 110
attachments attach a file to a Note, 101
attach a file to outgoing message, 104
download attachments, 105, 107
export attached photo to iPhoto, 105
view as a contact sheet, 106
Bcc, what is it? 87
blue orb, 81, 83
Cc, what is it? 87
Characters viewer, how to use it, 254
classic version of Mail, revert to it, 81
compose a message, 86–87
Connection Doctor, 389
Conversations delete one, delete them all, 85
examples of, 82, 84–85
how to work with them, 84–85
data detectors in, 82, 102–103
date, organize messages by, 82
dictionary, look up a word in, 259
Dock icon Downloads folder icon in, manage it, 105, 107
Mail icon, take advantage of it, 98
email add a link or a web page, 139
add attachments to, 105
won’t go out, what to troubleshoot, 388–389
Favorites Bar in
add, delete, or rearrange items in, 82
turns into Search Bar, 96–97
filters, also called Rules, 91
flagged messages, 90, 96
color coded, 100
Fonts panel in, preview fonts, 252–253
formatting options in, 86
if you can’t format the text, 87
forward messages, 86
full-screen view, 82
hover to display tool tips, 31
HTML mail as stationery, 88
green orb, 83
full-screen view, 82
forward messages, 86
formatting options in, 86
Fonts panel in, preview fonts, 252–253
flagged messages, 90, 96
filters, also called Rules, 91
Smart Mailboxes, 92–93, 97
SMTP (Outgoing Mail Server),
78–79, 388
send email from a different
SMTP account, 87
paste and match style, 61
PDF, create and email one, 230
Photo Browser
add photos to mail messages, 104
add photos to stationery, 89
photos
appear in Message Pane, 81
e-mail photos of yourself, 236
how to make them appear, 82
Plain Text does not allow formatting, 87
preferences you can change
Composing preferences, set defaults, 87
how often to check for mail, 81
number of lines that show in the
Message List, 81
Rules to filter incoming mail, 91
sending to a Group, do not include
all addresses, 116
text labels under toolbar icons, 81
Previous Recipients list, 86
prioritize an outgoing message, 86
Quick Look to view attachments, 106
read your email, 81–85
open email message in separate
window, 81
red dotted lines in message, 86
reply, reply all to messages, 86–87
Reply to (another address), 87
resize
Mail window, 82
panes, 82
Rich Text, allows formatting, 87
Rules to filter messages, 91
save as draft, 83
search messages, 96–97
Spotlight search in, 354, 368
send
a file with a page proxy, 267
a message, 86–87
attachments, 104
messages to a Group of people, 116
Sidebar
gear icon in, Smart Mailbox, 92
hide or show it, 83
in typical Mail layout, 84
mailboxes in, 90
Messages in, 99–101, 100–101
signatures
create your own, 94–95
menu listing signatures, 87
Smart Mailboxes, 92–93, 97
SMTP (Outgoing Mail Server),
78–79, 388
send email from a different
SMTP account, 87
speech, have text read aloud to you, 257
spell checker, 248–251
with contextual menu, 43
stationery, how to create it, 88–89
threads in. See herein Conversations
toolbar
customize the toolbar, 82
view text labels under icons, 81
tool tips in, 31
troubleshooting
email won’t go out, 388–389
Mail account in general, 387–389
unfolds itself, the message, 82
User Authentication, 79
user name and password
enter to create account, 76–80
vendor account password might
be different, 387
vCards for contact info, 266
Mail, Contacts & Calendars, 76
map a location, 103, 115
MarinerWrite, 57
master password, 331
math symbols, how to type, 254
McDonald, Nikki, 84–85, 91
McMillin, Jamie and Carla, 81–83, 99
McNally, Barbara, 203, 251
menu bar and menus
where is the menu bar? 4
date and time in menu bar,
customize the display, 291
finds commands in menus, 32
keyboard shortcuts instead of using
the menu, 28–29
symbols for modifier keys, 28, 445
metadata, make it searchable, 358
migrate your files, 437–439
Microsoft Exchange
Exchange calendar
set it up in System Preferences, 76
set it up in iCal, 156
set it up in Mail, 77–79
sync Address Book with Exchange, 111
Microsoft Word
open Word docs in TextEdit, 72
save files as Word docs in TextEdit, 73
migrate your files, 433–441
minimize windows
Dock Exposé to minimize and display application windows, 304
preferences for minimizing, 275
yellow button to minimize, 7
Mission Control, 296–305
example of screen, 296
preferences for, 298, 303–306
MobileMe
free chat account with, 168
free email account with trial, 76
iDisk, use it to transfer files, 440
mailboxes in Mail, 122–123
movies, export from QuickTime Player, 242–243, 245
set up account easily, 76
share Address Book contact list, 122–123
share iCal calendars, 163
sync Address Book with, 111
tutorials for, 33
modifier keys for keyboard shortcuts, 28, 445
mouse
contextual menus with, 42–43
gestures with mouse, 19, 290
hover, how to, 31
right-click, turn it on for your mouse, 290
system preferences for, 290
movies
bookmarks in a DVD movie, 226
full-screen DVD view, toggle between, 228
iChat Theater to share movies, 180
make a movie of yourself at the computer
with Photo Booth, 239
with QuickTime Player, 244
special effects in, create in
Photo Booth, 237
trim movie clips in QuickTime Player, 242
watch movies
in iTunes, 195
in QuickTime Player, 240–241
with dvd Player, 226–228
Movies folder in Home folder, 9
Multi-Touch gestures. See gestures.
Multi-Touch input device, 7, 19
music. See iTunes.
Music folder in Home folder, 9
music symbols, how to type, 254
name of your Mac, 392
Nelson, Jan, 184
networking
Location settings, 384–385
Network Diagnostics tool, 385
network port configurations, 382–383
Network preferences, 382–385
network your computers, 390–391
peer-to-peer network, 391
set service order for connectivity, 383
news. See RSS feeds.
Next and Previous buttons in Finder windows, 7
No Access to a file, 444
non-contiguous, what is it? 67
Non-Designer’s Presentation Book, 55
numbered list
example of in Mail’s Notes, 99
example of in TextEdit, 64
Numbers, not covered in this book, 55
Open dialog box
open a file you created earlier, 44
search for files in, 369
organize
color labels to color-code files, 278
columns, add sorting columns, 278
Outgoing Mail Server (SMTP), 78–79, 87, 388
Pagehand, 57
page proxy, take advantage of it, 267–268
Pages, not covered in this book, 55, 57
pair a remote with your Mac, 423
parental controls
on the web in Safari, 144
user account and parental controls, 344–346
partition the hard disk, 436
passwords
Admin password, 421
versus login password, 422
Apple id to reset password, 331, 337, 415, 421
choose not to have a password, 421
e-mail account password versus Internet account password, 79
forgotten passwords, how to change, 415, 422
hint for forgotten password, 332, 334–335, 337
Keychain access stores passwords, 420
login passwords, 337, 422
master password, 331
require password to wake from sleep, 426
reset Admin password, 436
set a firmware password, 436
tips for choosing, 422
paste and match style, 61
Path bar in Finder window, 6–7
PDFs
add to iPhone or iPad, 230
annotate a PDF, 212–213, 214–215
make a PDF, 229–231, 258
Preview
use it with PDFs, 208–217
Bookmarks in PDFs, 210
copy editable text from, 211
search a PDF in, 209
preview a document as a PDF, 53, 258
save Address Book info as PDF, 124
save documents as, 73
save to Web Receipts Folder, 230–231
send as attachment, 104
signature, digitize it for documents, 216
peer-to-peer network, 391
permissions
what are the options? 444
Get Info pane, set and change permissions, 343, 393, 444
Personal File Sharing, 392–399
phone
audio chat via iChat, 174–175
FaceTime for video chat from computer, 185
send text messages via iChat, 170
Photo Booth, 236–239
4-up, old photo booth photos, 238
icon in Dock, 22
make a movie of yourself at the computer, 239
printing options in, 319
photographs
add to Address Book contacts, 112
add to Mail stationery, 89
attach to email, 104
tool tips in, 30
tools for Preview, 202
touch gestures, 19
track a managed user's use of the computer, 347

Quick Look
view photos in Mail, 106
tool tips in, 30

Pine, 188, 189
Png files, change to another format, 207
Pointers, tip is the only hot spot, 25
PostScript, save a file as, 230
Preferences. See also System Preferences and individual apps
brief overview, 51
delete preferences file to troubleshoot an app, 413
delete third-party system prefs, 292
Preview application, 201–219
open images or documents in Preview, 202
colors, adjust them, 205
Contact Sheet view, 202, 208
Continuous Scroll option, 208
crop an image, 204
duplicate a file, 203
duplicate a folder, 203
fax a document from, 219
icon in Dock, 22
import images into Preview from a camera, 207
PDFs, how to work with, 208–217
annotate a PDF, 212–213, 214–215
Bookmarks in PDFs, 210
copy editable text from a PDF, 211
create page or web links on a PDF, 214–215
display facing pages or continuous pages, 208
open multiple PDFs simultaneously, 208
search a PDF, 209
preview page before printing, 53, 258
print documents or images from, 218
scan images into Preview, 207
shredders, how to make them, 206
sepia tone, change photo to, 205
Sidebar
open thumbnails in, 202
results of PDF search in, 209
view multiple PDFs in, 208
signature, digitize it for documents, 216
size, resize an image, 205
Thumbnails view, 202, 208
tool tips in, 30
unlock a file, 203
versions of files, 203
Previous and Next buttons, 7
Printing, 313–325
access special features of your printer, 318
of your software, 319
add a printer, 314–316
drivers for printing, 314–316
how many pages left to print? 323
icon in Dock for printer, 323
PDFs, create through the Print dialog box, 229
preview before you print, 53, 258
printer utilities, how to access, 324
Print & Scan Preferences, 314–316
privileges, 343, 393, 444
Public folder
where is it? 342
in Home folder, 9
share its contents with others, 342, 392–393
Pumpkin, 361
Put Back an item you threw away, 27
queue in printing process, 322–323
Quick Look
attachments in email, 106
how to use it, 20–21
preview of search results in Spotlight, 352, 361
QuickTime Player, 240–245
quit the open application, 263
force quit an application, 408
radio, listen to in iTunes, 196
Read Only permissions, 444
Read & Write permissions, 444
Recent files, display on screen, 302–305
red button in Finder window, 7
red dots under words, 66, 248, 250
region codes in DVDs, 227
relaunch the Finder, 409
remote, Apple remote
prevent it from controlling computers around you, 423
Remote for iPhone or iPad, 197
remote install Lion on a MacBook Air, 441
repair disk, 411
repair permissions, 410, 436
replace text, 60
reset button on modem box, 386
restart to fix minor Mac problems, 409
Restore System From Backup, 437
resume feature in Lion, 409
right-click
contextual menus and, 42–43
set it up as the "secondary click," 290
when it might be a left-click, 290
Riley, Barbara, 368
Rosetta, 352
rotating cube Desktop, 338–339
RSS feeds in Safari, 145–151

Safari
Auto-Click to open collection in tabs, 134
AutoFill, fill in user IDs and passwords automatically, 135
block pop-up windows, 135
bookmarks
Auto-Click to open all bookmarks, 134
Cover Flow view, hide or show it, 133
open a collection of bookmarks in tabs, 134
organize bookmarks into folders, 132–133
RSS feeds, bookmark them, 148
show all bookmarks, 130
+ sign to add a bookmark, 130
tabs, create bookmark folder from, 153
Bookmarks Bar
where is it? 130, 132
open a collection of bookmarks in tabs, 134
save a bookmark or folder into Bookmarks Bar, 132
Bookmarks Menu, 132
children browsing the web, make it safer, 144
Collections (of bookmarks), 132–133
make a collection from tabbed windows, 153
dictionary, look up a word in, 259
downloads, keep track of them, 153
e-mail a web page or a link, 139
enlarge or reduce contents on a web page, 136
faV icon in address field, 266
favorite web pages, easy access to, 131
fraudulent site, warn when visiting, 152
full-screen mode, 130
History menu
private browsing does not track history, 143
reopen windows, 153
search the History, 133
icon in Dock, 22
icons in Safari toolbar
A, large and small, 136
book icon, 132, 133
book icon with lock on it, 144
circle with arrow, 130
double arrow on right end, 130
downward arrow on right end, 153
eyeglasses for Reading List, 151
magnifying glass, 130
Mail icon, put one there, 139
number in parentheses, 148
orange arrow in circle, 136
plus sign +, 130, 153
Reader badge in address field, 150
RSS, 145–150
scissors (web clip widget), 141
square next to name in Bookmarks Bar, 134
Top Sites (grid icon), 131
triangle in Bookmarks Bar, 148
parental controls for, 144
PDF documents, view in Safari, 139
pop-up windows, block them, 135
print web pages, 142
private browsing, 143
Reader view, 150
Reading List feature, 151
reload a web page, 130
resize the browser window, 130
the text on the web page, 136
RSS feeds, 145–150
as screensaver, 150
bookmark them, 148
open a collection of feeds in tabs, 134
save an entire web page, 140
an image from a web page, 140
scrolling with gestures, 152
search in Safari
Bing, from Google search field, 130
find a word or phrase on the current page, 138
Google and others, 130
SnapBack to a search results page, 136
use tabs to open results pages, 137
Yahoo! from Google search field, 130
Services available in menu, 270
SnapBack to a search results page, 136
speech, have text read aloud to you, 257
Spotlight search will send to web, 360
status bar in browser window, 31, 130
tabs
how to use them, 137
close one tab or all tabs, 134, 137
merge windows into tabs, 153
Toolbar
customize it, how to, 130
add Mail link, 139
add resize text button, 136
add web clip widget, 141
tool tips in, 31
Top Sites, 131
web clip widgets, 141
web location file, add to the Dock, 266
web pages know my contact information—stop it! 135
web pages—scroll, swipe, arrow keys, 153
safe boot to fix minor problems, 412
save your files
save a duplicate, 59
save as a different file format, 73
save into a particular folder, 44, 266
save versions of a file, restore a previous version, 58–59
search the Save dialog box for folder to save into, 369
scanning
scanner, set it up, 325
use Preview to scan, 207
screen saver
preferences to set it up, 291
RSS feeds as screen saver, 150
set a lock on it for security, 426
screen sharing
globally, over the Internet via iChat, 404–405
via the Go menu, 403
locally, on the network
via Bonjour, 404
via Finder window, 402
via Go menu, 403
end screen sharing
through the Sidebar, 402
through the Go menu, 403
through iChat or Bonjour, 405
Sharing preferences pane for, 401
screenshots
make screen recordings, 245
make screenshots with keyboard shortcuts, 443–444
make with Preview, 206
scrolling, scroll bars
change the scrolling preferences, 115
hide or show the scroll bars, 6
scroll with inertia, 290
search
in Address Book, 118–119, 368
in Mail, 96–97
on your Mac, use Spotlight, 352–369
search field
what it looks like, 53
x in search fields, 309
Secure Shell, 420
security on your Mac, 419–431
See also privacy
automatic login, turn it off, 425
disable remote control receiver, 423
crypted disk images, create them, 427
FileVault for heavy-duty protection,
430–431
firewalls, 420, 424
Keychain Access
what is it? 420
how to use it, 428–429
set up screen saver lock for security,
426
laptops, special security tips for, 431
login, logout
disable automatic login, 334
login as standard user, 426
logout after certain number of minutes, 423
passwords
forgot your Admin password? 422, 436
require password to wake from sleep,
426
set up screen saver lock, 426
tips for creating passwords, 422
require Admin password to change preferences, 423
require user password to wake from sleep, 426
Safari, warn when visiting a fraudulent website, 152
set a firmware password, 436
Trash, empty it securely, 427
turn off Sleep and Shut Down buttons at login, 425
selecting documents and files in Finder windows, 40–41
Services
overview of and how to use, 270
add text as voice to iTunes, 257
Shared folder, 342
Shared item in Finder window
hide the shared names, 6, 36
share your printer with other Macs,
320–321
sharing files. See file sharing
Sharing system preferences, 392–393
share a printer, 320–321
Sheldon, Carmen, 329
Shift key
select multiple files with, 41
use in keyboard shortcuts, 28, 445
Show View Options
for Column View windows, 285
for Cover Flow View windows, 286
for Icon View windows, 280–281
for List View windows, 282–284
for the Desktop, 287
Shut Down to fix minor problems, 409
Sidebar
AirDrop, share files via, 399
Burn Folder, add to Sidebar, 224
shared volumes in, 397
disconnect from, 398
screen share via a shared volume, 402
show Shared volumes in, 394, 398
Sidebar in Finder windows
where is it? 6, 12–13
add folders to the Sidebar, 8, 12
add files to a folder in the Sidebar, 12
Applications folder, 48
customize the Sidebar, 9, 12, 13
delete folders from the Sidebar, 9, 12
Devices in, 37–38, 276
eject symbol in, 37
Favorites in, add or remove, 36
gear icon in, saved search in
a Smart Folder, 366
hide the Sidebar, 6
Home, add yours to the Sidebar, 8, 279
resize the Sidebar, 6
Shared in, 37–38
signature
digitize your real signature, 216
Mail signatures, 94–95, 87
Simple Finder, 344–347
slideshows
in Cover View in Finder windows, 18
in Mail, view email attachments as, 106
in Photo Booth, 238
Smart Folders
in Spotlight, 365–366
Smart Mailboxes based on search parameters, 97
Smart Quotes in TextEdit, 68
SMTP (Outgoing Mail Server), 78–79, 388
send email from a different SMTP account, 87
Software Update preferences
to help troubleshoot, 414
update security features, 420
Spaces
how to set up and use Spaces, 298–301
add a new Space, 299
Dashboard
is in a Space by default, 310
remove Dashboard from a Space, 298
to examples of Spaces on screen, 299
remove a Space, 301
speech, speak aloud
have text read aloud to you, 257
mail messages, 43
TextEdit text, 71
spell checker, 248–251
in TextEdit, 66
with contextual menu, 43
Spotlight
how to use Spotlight, 352, 360–361
comments in Get Info panel, 283
Finder window search
do a quick search, 353, 362
narrow the search with Boolean operators, 364
narrow the search with parameters,
363
keywords, add to files for searching, 359
metadata, make it searchable, 358
preferences
Finder preference to search this Mac, 353
keyboard shortcuts for, 356
search results found in, 355
privacy features in, 356
search in
Address Book, 118–119
Mail, 96–97, 354, 368
Open dialog box, 369
Save dialog box, 369
System Preferences, 293, 367
TextEdit, 354
web pages, send search to, 354
search for attributes, not just file names,
357, 358
Smart Folders for automatic searches,
365–366
sort the search results, 363
spring-loaded folders, 268, 276–277
stacks in Dock, 22–25
startup disk, choose which to start up from, 436
Status Bar
in Finder window, 6–7
in Safari window, 31, 130
Stickies application, 234–235
string, what is it? 444
support communities for the Mac, 33
swipe, swiping. See gestures
switch for connectivity, 391
System Preferences
overview of, 288–289, 293
alphabetize the System Preferences pane, 288
delete third-party preferences, 292
Finder preferences, 276–279
icon in Dock, 22, 288
require Admin password, 421
scroll bars in windows, 6
search for the one you need, 293, 367
specific preferences
Dashboard (widgets), 298, 310
Date & Time, 291
Desktop & Screen Saver, 291
Dock Exposé, 304
Dock preferences, 22, 274–275
Exposé, 298, 303
Keyboard, 289
Mail, Contacts & Calendars, 76
Mission Control, 298, 303, 310
Mouse, 290
Network, 382–385
Print & Scan, 314–316, 321, 324
Safari, 51
Scanner prefs (Print & Scan), 325
Security & Privacy, 423, 430–431
Sharing, 320, 392–393, 401
Software Update, 414, 420
Spotlight, 355, 367
Trackpad, 290
Users & Groups, 421, 425–426
speech, voice used for, 257
tool tips in, 289
tables in word processing, 65
tabs and indents in TextEdit, 62–63
Target Disk Mode to transfer files, 416
technical symbols, how to type, 254
television shows, watch in iTunes, 195
text clipping
make a text clipping, 265
Spotlight can’t search in, 357
TextEdit
AutoSave in, 59
can’t format text? 71
capitalize first letters, 70
case, change upper- and lowercase, 70
Characters viewer, how to use it, 254
Complete command to finish typing a word, 71
data detectors in, 70
dictionary access in, 71, 259
drag text and drop on Mail icon in Dock, 269
duplicate file, 59
find and replace, 60
Fonts panel in, preview fonts, 252–253
links in, email and web, 68–69
new document, create one, 58
numbered lists, 64
page numbering in, 66
page proxy, take advantage of it, 267–268
paste and match style, 61
PDF, save documents as, 73
quotations marks in, 68
Recent files, display on screen, 302–305
ruler, hide or show it, 71
saving files in, 59
search in document, 354
select non-contiguous text, 67
speech, have text read aloud to you, 257
spell check in, 43, 66, 71, 248–251
style sheets in, how to create and use, 61
Substitutions, 68–70
tables, how to create, 65
tabs and indents, 62–63
text clipping, make one, 265
text
  can’t format the text, 71
  runs across the entire page, 71
thesaurus, look up a word in, 259
tool tips in, 30
Transformations in, 70
unsaved changes, save them, 58
versions in, restore previous, 59
Wikipedia, look up a word in, 259
Wrap to Window or Wrap to Page, 58
Trash, 26–27
empty it securely, 279, 427
icon in Dock, 22
Put Back an item you trashed, 27
warning, turn it on or off, 279
what’s in it? 27
troubleshooting
Address Book, my contacts won’t show up, 118
can’t change the background or color of a Finder window, 280
columns in window won’t move, 278, 283
computer is dead, use Target Disk Mode to transfer files, 439
delete preference file for an application, 413
dial-up connection keeps trying to log on, 81
disk is stuck in the drive, 417
Disk Utility
repair disk permissions, 436
reset passwords, 436
Dock is missing, 23
double-click, can’t do it fast enough, 290
empty Trash warning, turn it off, 26–27
files
file is locked, 343
file won’t open, 343
file sharing, I get confused which computer I’m looking at, 394
find earlier versions through Time Machine, 376–378
Time Machine, 371–378
Local Snapshots, 375
restore system from backup, 437
Spotlight search in, 367
TextEdit versions are similar, 59
time zone, customize it for your Mac, 291
title bar in Finder window, 6
Toolbars
contextual menus in, 43
customize the Toolbars, 51
hide Finder window Toolbar, 7
tool tips
what are they? 30–31
in System Preferences, 289
Top Sites in Safari, 131
Trackpad
general use of with gestures, 7, 19, 290
gestures
  in Mission Control, 297
  in Safari, browse web pages, 152
  in Spaces, move between Spaces, 300
iCal, turn calendar pages with, 156
system preferences for, 290
transfer files. See also file sharing,
from one Mac to another, 437–439, 440–441
transfer music, 192–193
Trash, 26–27
empty it securely, 279, 427
icon in Dock, 22
Put Back an item you trashed, 27
warning, turn it on or off, 279
what’s in it? 27

Server icons connected to Mac, can’t find them, 398
Shut Down to fix minor problems, 409
Sidebar is missing from my Finder window, 7
System Preferences, I can’t change them, 289
target disk mode to get data from a computer, 416
test in another user, 414
things just happen
all my windows disappear, 302
application fills the screen,
how to get back to the Desktop, 300
folders spring open, 268
thumbnail pictures appear at the top of the screen, 299
when I click a Dock icon, the screen jumps, 298
when my cursor gets close to a corner (hot corners), 298, 303
Toolbar missing from Finder window, 7
typing, text
can’t format text, 71, 87
green or red dots under words, 248, 250
keeps changing automatically, fixing the spelling, 250
keys keep repeating themselves, 289
won’t drag anywhere, 264
types the entire width of page, 71
update your system software, 414
user account, can’t change it, 339
use the Install disk to troubleshoot, 436
web browser knows my contact information, 135
window is missing the Sidebar, Toolbar, etc., 7
windows spring open and I don’t like it, 277
tutorials for Mac support, 33
two-button mouse
contextual menus with right-click, 42
set it up for right-clicking, 290
typographer’s quotes, 68

update your system software, 414
upgrade to Lion, 433–441
backup before upgrading, 434
clean install instead of upgrade, 435
migrate your files, 437–439
on a Mac that doesn’t have an optical drive, 441

USB Flash drive
install with, 436–437
reset Admin password with, 422
user accounts, 327–349
overview of multiple users, 327–328
Admin user, 328–329
give others Admin privileges, 339
preferences are locked, you can unlock them globally, 423
Apple ID
allows login from another computer, 331, 333, 421
allows user to change her own password, 331, 333, 421–422
automatic login, 334, 337
create new users, 331–336
delete a user, 348–349
fast user switching, 334, 336
set it up and use it, 338–339
lock screen instantly through this menu, 425
file sharing with other users, 342
Group account, make one, 336
Guest account, 329, 330
login, logout
automatic login, 334, 337, 425
disable automatic login, 423, 425
Login Items, set them up, 341
login picture for, 333
logout, 337
managed users
overview of, 328–329
parental controls for, 344–347
run full Finder while in Simple Finder, 347
passwords, 332
Admin password versus login password, 422
password hint, 332, 334–335, 337
reset password if you forgot, 422
tips for creating passwords, 422
Simple Finder, 344–347
disable it, 347
standard user, 328–329, 340
can act as a security measure, 426
can change her own password with Apple ID, 421–422
users
fonts, install for just one user, 232
forgot your Admin password, 415
Spotlight search in, 353
System Preferences for individual users, 289
troubleshoot new app in a new user, 414
vCard, or virtual card, 111
send one to others, 119
versions
in Preview, 203
in TextEdit, 59
video chat
one-on-one in FaceTime, 185
with up to three others, 176–177
video tutorials for the Mac, 33
View Options pane
for Column View windows, 285
for Cover Flow View windows, 286
for Icon View windows, 14, 280–281
for List View windows, 282–284
for the Desktop, 287
visual clues
blue column heading in Finder windows, 15
corner dots to enlarge or reduce widget window, 309
magnifying glass in corner of screen, 352
menu items are gray or black, 29
printing clues, 323
Quick Look, icons to open in, 21
TextEdit unsaved changes, 58
tiny arrow in left corner, 267
triangles in column heading of Finder window, 15
vnc address, 401, 403
VoiceOver, at login window, 336
VPN, Virtual Private Network, 420

wallpaper, set the Desktop background, 291
web clip widgets, 141
web links in TextEdit, 68–69
webloc, web location file, 444
web pages
add a web location to the Dock, 23, 266
browser for. See Safari.
icChat Theater to share web pages, 180–181
PDFs, create web page links in, 214–215
save shopping receipts, 230–231
Web Receipts Folder, 230–231
WEP, Wired Equivalent Privacy, 420
whois, check it, 437
widgets, 306–311
web clip widget, 141
Write Only permissions, 444

Wikipedia
Dictionary panel can access, 259
Spotlight search sends to Wikipedia, 360
Williams family
Florence Weber, 89
Gerald Williams, 89
Jimmy Thomas, 88, 112
John Tollett, 89
Pat Williams, 89, 309, 333
Pauline Williams, 89, 269
Ryan Williams, 84–85
Scarlett Williams, 140
Shannon Williams, 185
Tyler Williams, 89
windows. See Finder windows
Windows
share files with Windows users, 393
share music with Windows users, 192–193
wireless
keyboard, battery power of, 289
mouse, preferences for, 290
trackpad, preferences for, 290

word processing. See also TextEdit
find and replace example, 60
numbered list, example of, 64
open and save Word files in TextEdit, 72–73
style sheets in, example in TextEdit, 61
tables, example of in TextEdit, 65
tabs and indents overview, 62–63

Yahoo!
search with Yahoo! in Safari, 130
sync Address Book with, 111
Yahoo calendar
set up in iCal, 156
set up in System Preferences, 76
Yahoo! Messenger chat account, 168

yellow button to minimize window, 7, 275, 304–305

YouTube
make a movie of yourself
in Photo Booth, 239
in QuickTime Player, 244
movies
export from QuickTime Player, 242–243

Zaorski, Linnzi, 52, 189
This page intentionally left blank
Unlimited online access to all Peachpit, Adobe Press, Apple Training and New Riders videos and books, as well as content from other leading publishers including: O’Reilly Media, Focal Press, Sams, Que, Total Training, John Wiley & Sons, Course Technology PTR, Class on Demand, VTC and more.

No time commitment or contract required! Sign up for one month or a year. All for $19.99 a month.

SIGN UP TODAY
peachpit.com/creativeedge